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1. Background 

Informed Delivery is an optional, free feature that gives residential consumers the ability to 

digitally preview their mail and manage their packages from one convenient location. 

¶ Through Informed Delivery, users/subscribers can view images of letter-size mail and 

color images from participating mailers via email notification or online dashboard at 

informeddelivery.usps.com. 

¶ Package tracking information on Priority Mail Express®, Priority Mail®, and other parcels 

is available as well. 

¶ This feature offers consumers the convenience of seeing what is coming to their mailbox 

and PO Boxðwhenever, whereverðeven while traveling. 

Participating mailers can provide supplemental content, allowing users to take immediate 

action on a mailpiece. 

Informed Delivery ñinteractive campaignsò or just ñcampaigns.ò 

The United States Postal Service (USPS®) currently offers the 

basic campaign functionality described in this document for no 

additional fee. Monetization opportunities for additional features 

are under consideration. 

Figure 1 depicts a sample Informed Delivery email 

notificationðreferred to as the ñDaily Digestòðwith an 

interactive campaign that is included with the grayscale 

scanned image of a marketing letter.  

Underneath the scanned image is clickable supplemental 

content, also known as a ñRide-along Image.ò The mailer name 

and a clickable ñLearn Moreò link are provided as part of a basic 

campaign.  

The bottom image illustrates a scanned handwritten letter. 

1.1. Availability 

Informed Delivery is available to eligible residential consumers in the majority of ZIP 

CodesÊ across the country. Not every address in a ZIP Code is eligible for Informed 

Delivery. For instance, a multi-unit building that is not individually identified and coded down 

to a unique Delivery Point ZIP CodeÊ at the unit level is not eligible for Informed Delivery. 

1.2. How It Works for Consumers/Mail Recipients 

USPS uses existing processes that provide digital images of the exterior of mailpieces as 

they are processed through automation equipment; those images are used to provide digital 

notifications to users in advance of the delivery of physical mail. The scanned images can 

be viewed in a userôs email notification or on the userôs personal dashboard at 

informeddelivery.usps.com. The process flow is depicted in Figure 2. 

 

FROM Retailer 

Name 

Figure 1. Depiction of Informed 
Delivery Daily Digest. 

http://informeddelivery.usps.com/
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Figure 3 depicts how a physical mailpiece image (without an interactive campaign) is 

displayed on the userôs Informed Delivery dashboard. Within the dashboard, mailpiece 

information is  

maintained for a period of seven calendar days. Users have the ability to toggle between 

their ñMailpiecesò and ñPackagesò tabs to preview mailpiece images or to manage and track 

packages. Learn more about this consumer-facing feature and sign up at 

informeddelivery.usps.com.   

1.3. How It Works for Mailers/Mail Owners 

Informed Delivery users will see images of their mail, regardless of whether or not a mailer 

conducts an interactive campaign. Mailers can enhance their hardcopy mailings by 

conducting a campaign that includes custom images and a website link (URL). This 

information will appear in the userôs email digest or on the dashboard at USPS.com®. This 

information is referred to as supplemental content. 

¶ Each unique set of customized supplemental content is associated with an individual 

mailing. Multiple interactive campaigns can be conducted at one time for a single 

mailing. Multiple mailings and campaigns can be conducted simultaneously. 

Figure 2. Process flow that enables Informed Delivery 

Figure 3. Depiction of Informed Delivery Dashboard View 

http://informeddelivery.usps.com/
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¶ Each campaign is triggered by and mapped to a single Mailer ID (MID) within an 

Intelligent Mail® barcode (IMb®) that is used on the mailpiece, customized to be active 

during a defined date range. 

¶ More information on the MID and the IMb can be found in Appendix B. 

When the Informed Delivery application receives a mailpiece scan for an enrolled Informed 

Delivery user and the MID or the MID + Serial Number in the IMb is associated with an 

active mailer campaign, that user will see customized supplemental content that the mailer 

provided USPS. The process for this is illustrated in Figure 4. 

The interactive campaign content is currently displayed 

below the image in the email and Informed Delivery 

dashboard, as depicted in Figure 5. USPS is considering 

additional template designs in the future. 

  

Figure 5. Informed Delivery dashboard 
view with an interactive campaign 

Figure 4. Process flow showing when USPS applies Informed Delivery campaigns 
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2. Benefits for Mailers 

Informed Delivery allows mailers to: 

¶ Take advantage of a new digital channel, tying hardcopy mail to digital content. 

¶ Receive an additional digital impression for the intended recipient and additional 

impressions for other household members who are Informed Delivery users. 

¶ Experience high email open rates (over 60% daily average). 

Informed Delivery interactive campaigns provide additional benefits, allowing mailers to: 

¶ Enhance the scanned mailpiece images that consumers are already receiving. 

¶ Give the mail recipient or other household members the opportunity to take action 

immediately on their mailpiece by clicking on a campaign image/website linkð

regardless of whether or not they retrieve mail from the physical mailbox. 

¶ Coordinate multi-channel campaigns. 

¶ Collect information on campaign reach and results (e.g., open rates, click-through rates) 

through data analytics. 

3. Participation Criteria 

Virtually any mailer can conduct an Informed Delivery campaign if the following criteria are 

met: 

¶ Mailpieces must be automation compatible 

o Available for First-Class Mail®, Periodicals, or USPS Marketing MailÊ letter-size, 

postcard, or flat-size pieces such as large envelopes, catalogues, and 

magazines. 

¶ Mailpieces must contain a valid IMb. 

¶ Mailer or Mail Service Provider (MSP) must be IMb certified. 

A campaign can be initiated by the mailer or by their designated MSP (advertising agency, 

printer, freight shipper, presort bureau, etc.). 

4. Creating a Campaign 

The overall campaign process is simple; mailers create and induct hardcopy mail as usual 

and provide USPS data elements and supplemental content to facilitate an Informed 

Delivery interactive campaign. Mailers need to determine the level of campaign they will 

conduct, the type of campaign, the supplemental content that will be used, the campaign 

start and end dates, etc. Each of these are described in the sections below. 

4.1. Levels of Interactive Campaigns 

At this time, there are two levels or breakdowns of campaigns available (Figure 6): 

4.1.1. Mailer ID (MID) 

All mailpieces with this MID have the same campaign applied, therefore all Informed 

Delivery users see the same campaign. 

¶ Note: This method cannot be used with shared MIDs. 

4.1.2. Intelligent Mail® Barcode (IMb®) Serialized 
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All mailpieces with the same MID and a defined Serial Number range within the IMb create a 

unique campaign. 

¶ This campaign level provides the ability to apply different campaigns to groups of 

customers and the ability to use a ñsharedò MID, such as one that might be used in large 

businesses with multiple business units or one provided by a MSP. 

¶ These campaigns are defined with a unique and sequential Serial Number range for 

each campaign treatment desired. 

¶ Dividing the mailing list into campaign groups prior to printing/addressing the actual 

mailpieces or assigning the IMbôs is critical. 

¶ See Appendix C. The Mailing Lifecycle for more information on this topic. 

¶ The majority of interactive campaigns are conducted using this level. 

 

 
 

4.1.3. Personalized 

USPS tested mailpiece-level campaigns via PostalOne!® in April-July 2018. Additional 

testing is suspended while system performance enhancements are conducted. Personalized 

campaigns will eliminate the need to do mailing list sortation and segmentation prior to 

printing or IMb assignment and it will allow the ability to apply a unique interactive campaign 

to each user, based on an individual IMb. Additional information on the availability of 

personalized level campaigns will be provided when available. 

4.2. Types of Interactive Campaigns 

There are two types of Informed Delivery campaigns available. 

4.2.1. Basic Campaign  

¶ Ride-along Image and Target URL - Figure 7: This campaign includes the USPS 

grayscale scanned image of a letter-size mailpiece and an image provided by the mailer, 

currently placed below the grayscale image in the email and dashboard. In all cases, the 

Ride-along Image is clickable (interactive), as is the additional ñLearn Moreò link. These 

are both linked to the same URL. All URLs must begin with https. The ñLearn Moreò field 

name/text is not editable. 

o Important Notes: A Ride-along Image and URL are required to conduct an 

Informed Delivery campaign. All URLs must lead directly to a landing page 

directly associated with the physical mailpiece. See our Informed Delivery 

Interactive Campaign Mailer/Submitter Terms and Conditions for full details. 

4.2.2. Dual Campaign  

¶ Representative Image, Ride-along Image, and Target URL - Figure 8: In addition to 

the required Ride-along Image and URL, this campaign type includes an image that is 

Figure 6. Illustration of MID and IMb Serialized Campaigns 

https://www.usps.com/business/pdf/informed-delivery-campaign-mailer-submitter-terms-and-conditions.pdf
https://www.usps.com/business/pdf/informed-delivery-campaign-mailer-submitter-terms-and-conditions.pdf
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provided in lieu of a flat-size image or in place of a grayscale letter-size image. 

(Grayscale images of flat-size mail are not provided to consumers, however, scan 

events are captured for some flat-sized mailpieces during processing.) 

o Representative Images are static; they are not clickable/interactive. 

o These images must be clearly branded and must be clearly and directly related 

to the hardcopy mailpiece. See our Informed Delivery Interactive Campaign 

Mailer/Submitter Terms and Conditions for full details.  

 

4.3. Target URL Parameters 

Informed Delivery has released a system update to send campaign Mailer ID (MID) and 

Serial Number information in the form of URL parameters when consumers click on 

interactive campaign Target URLs. This update enables additional data to be captured, 

allowing mailers to better understand Informed Delivery driven referrals. Additionally, this 

update enables Target URL webpages to be dynamic based on campaign MID and Serial 

Number.  

 

Informed Delivery now appends the MID and Serial Number to the end of the mailer-

provided campaign Target URL as parameters for all interactive campaigns.  

 

If the campaign URL is a redirect, the end destination URL must be entered as the Target 

URL for the interactive campaign.   

 

As of October 29, 2021, mailers can opt out of URL parameters at a campaign level by 

selecting the option to disable URL parameters for a campaign submitted through the Mailer 

Campaign Portal (MCP).  

 

Figure 8. Informed Delivery 
notification with dual campaign 

Figure 7. Informed Delivery 
notification with basic campaign 

https://www.usps.com/business/pdf/informed-delivery-campaign-mailer-submitter-terms-and-conditions.pdf
https://www.usps.com/business/pdf/informed-delivery-campaign-mailer-submitter-terms-and-conditions.pdf
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There are three basic stages in the campaign process: Pre-Campaign, Campaign, and Post- 

Campaign. 

 

5.1. Pre-Campaign 

This defines the process of gathering the required campaign elements and determining the 

submission method as described in Section 4. For an overview of how to conduct a 

campaign in seven simple steps, see the Interactive Campaign Checklist in Appendix A. 

Interactive Campaign Checklist. 

5.1.1. Pre-Campaign Analysis Report 

USPS offers an optional Pre-Campaign Analysis report. For this analysis, USPS cross- 

references an uploaded list against a current Informed Delivery user list and provides an 

aggregate response indicating how many consumers in the list are Informed Delivery 

usersðat a given point in time. This information is provided in aggregate as USPS is 

prohibited from providing lists of Informed Delivery users. Pre-Campaign files can be 

submitted at any time, even after a campaign has been activated. 

The Pre-Campaign list/file must contain 11-digit Delivery Point ZIP Codes that are taken 

from the IMb of a recent mailing list. MSPôs are most commonly able to provide this 

information from the IMb. This delivery point information is not stored in standard customer 

databases. 

The file must meet the criteria below: 

¶ The header must read ZIP11. 

¶ Each entry must be an 11-Digit Delivery Point ZIP Code. 

o To delete line items without 11-digit codes, import the file containing the codes 

into Excel. Once in Excel, filter the data based on length, delete the non-11 digit 

codes, and save the document in .csv format. 

¶ Include leading zeroes. 

¶ Remove duplicate codes. 

¶ Save as a Comma Separated Values (.csv) file (using lowercase .csv). 

¶ Break files into 102,400 KB (or 100MB) or less. 

Figure 9 provides an example of how the Pre-Campaign file will look once it is 

ready for uploading in the MCP. If the file does not meet these criteria, it will not be 

uploaded or processed. 

Regardless of the intended campaign submission method, use the MCP to 

upload the properly formatted ZIP11 .csv file. See the Mailer Campaign Portal 

User Guide on the Informed Delivery for Business Mailers website for details 

on how to upload a file. 

¶ If an invalid file is uploaded in the Portal, the mailer will receive an error message 

explaining the file issue(s) that prevented a successful upload. 

Figure 9. Example 
of properly 
formatted Pre-
Campaign .csv file 
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¶ The report will be provided within the Portal when it is done processing. Processing time 

varies based on the file size. 

Important Note: To verify the contents of the Pre-Campaign data, right-click the file and 

open with a text editor such as Notepad. Appendix E. Formatting Pre-Campaign Analysis 

File outlines the step-by-step process for ensuring that the Pre-Campaign file is correctly 

formatted. 

The completed Pre-Campaign Analysis report, which is provided in the Portal, includes the 

following data: 

Column Definition 

A Pre-Campaign List Size Total number of 11-digit Delivery Point ZIPÊ Codes included 
in the .csv file uploaded into the Portal. 

B Eligible 11-digit 
Delivery Point ZIP 
Codes 

Total number of eligible 11-digit Delivery Point ZIP Codes 
included in the .csv file (not delivery points with users, but 
eligible delivery points). 
 

C Unique Eligible 11-digit 
Delivery Point ZIP 
Codes 

Total number of unique eligible 11- digit Delivery Point ZIP 
Codes included in the .csv file. 
 

D # of Subscribers Count of subscribers in the Unique Eligible 11-digit Delivery 
Point ZIP Codes in the .csv file. 

E Subscriber Saturation 
(%) 

# of Subscribers divided by Unique Eligible 11-digit Delivery 
Point ZIP Codes (Col D / Col C). 
 

F # of Email Enrolled 
Subscribers 

Count of subscribers who receive emails in Unique Eligible 11-
digit Delivery Point ZIP Codes. (Not all subscribers opt in to get 
emails.) 

G Email Enrolled 
Saturation (%) 

# of Email Enrolled Subscribers divided by Unique Eligible 11-
digit Delivery Point ZIP Codes (Col F / Col C). 
 

 

5.2. Campaign 

Campaigns are activated based on the requirements provided by the mailer/MSP, which are 

dictated by the campaign data elementsðas described in Section 4. 

The start date of the campaign, duration of the campaign, and campaign images that are 

provided result in the campaign being applied to each mailpiece, based on the information in 

the    IMb (see Figure 4). 

Figure 10. Pre-Campaign Analysis Report 
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In relation to the campaign elements, only the Brand/Campaign Display Name and 

supplemental content are presented to the Informed Delivery user. The other campaign 

elements provided are used in the background, to apply the appropriate campaign for the 

defined time period. 

5.3. Post-Campaign 

USPS understands that data analysis is important to measuring success and determining 

where to direct marketing funds and resources. The Post-Campaign Summary and Detailed 

reports provide a wealth of information related to an individual campaign. 

5.3.1. Post-Campaign Summary Report 

This report provides the general aggregated results of an individual campaign, including the 

number of users/mail recipients that were sent an email, the email open rate, and the 

number of click-throughs. 

¶ For campaigns submitted through the Mailer Campaign Portal (MCP) or PostalOne!, 

post-campaign reports are available for download via the Portal. 

¶ As of October 2019, post-campaign reports run daily overnight rather than on-demand 

by mailer request. Reports are cumulative and encompass all campaign activity through 

the report date. 

Column Definition 

A Campaign_Display_Name The name displayed in the ñFromò field of the campaign  
(sometimes referred to as Brand Display Name or Display 
Name). 

B Campaign_Title A mailer-generated title for a campaign. 

C Campaign_Code A mailer-generated unique code for a campaign. 

D Mailpieces The number of campaign-related mailpieces identified during 
mail processing that were sent to a unique Delivery Point 
Code (DPC) address. This is not the total number of 
mailpieces in the mailingðjust those identified as going to 
Informed Delivery users. 

E Emails The number of campaign-related emails generated from the 
number of physical pieces. All email users in a household are 
counted in this metric. 

F Email_Open The number of instances where a sent email was opened. 

G Email_Open_Rate The number of email opens divided by the number of emails 
(Col F/E). 
Å This metric can seem irregularly high (e.g., over 100%) 

if organizations look at it on a daily or regular basis, as 
opposed to holistically over the entire life span of a 
campaign. This can happen if users who receive their 
mailpiece do not open their email until a later date/time. 

H Click_Through The number of click-throughs generated from emails or 
dashboard. 
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I Click_Through_Rate The number of click throughs divided by the number of 
mailpieces (Col H/D). 

5.3.2. Post-Campaign Detailed Report 

Column Definition 

A Brand_Display_Name The name displayed in the ñFromò field of the campaign  
(sometimes referred to as Campaign Display Name or Display 
Name). 

B Mailer_ID The six-digit or nine-digit numeric code that was submitted for 
the campaign. 

C Campaign_Code A mailer-generated unique code for a campaign. 

D Campaign_Title A mailer-generated title for a campaign. 

E Submitter_CRID A Customer Registration Identification (CRID) is a USPS-
generated numeric code of up to 15 digits that uniquely 
identifies a USPS customer at a location. 

F Start_Date The start date of the campaign as specified by the mailer. 

G End_Date The end date of the campaign as specified by the mailer. The 
cut-off is at 12 AM of the end date. Mail processed on the 
campaign end date will not be included in any reports. 

H Start_Serial If the campaign is based on IMb Serialized (not MID level) ï 
indicates a six- or nine-digit starting Serial Number. 

I End_Serial If the campaign is based on IMb Serialized (not MID level) ï 
indicates a six- digit or nine-digit ending Serial Number. 

J MID_Serial The full 15-digit MID and the IMb Serial Number of that specific 
mailpiece. 

K ZIP5 The ZIP Code of the subscriber (recipient). 

L Mailpiece_ID A unique identifier for each piece. Automatically generated by 
USPS. 

M Delivery_Date The date that a mailpiece was processed for delivery. All times 
show as 5:00 GMT 

N Email_ID A unique identifier for each mailpiece. Automatically generated 
by USPS. 

O WhenWasEmailSent The time stamp of when an email was sent using GMT time 
zone. 

P WhenWasEmailOpened The time stamp of when an email was opened using GMT time 
zone. 

Figure 11. Post-Campaign Summary Report 
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Q ImagePositionInEmail The position in which the image was displayed in an email (1 
means it was the first image, 2 means it was the second 
image, etc.) 

R WhenClickedThrough The time stamp of when a link from a campaign was clicked  
using GMT time zone. 

S Source Where the click-through originated. Possible values: 
RIDEALONG_EMAIL; RIDEALONG_EMAIL_IMAGE; 
RIDEALONG_WEBSITE; RIDEALONG_WEBSITE_IMAGE. 

T Record_Type Distinguishes if the line of data is correlated to a mailpiece 
(Piece), a sent email (Email), an email open (Open Details), a 
piece that was sent to a user who isnôt enrolled in emails (Non-
Email), a piece that was not included in an email due to the 
user already having 10 images in their daily email (>10pcs), or 
click-throughs (Click Details). 
Å >10pcs type indicates that a specific campaign did not 
appear in a userôs Daily Digest email because the user 
received at least one other campaign and 10 or more 
mailpieces in total. However, there is a known defect with 
this record type. Please disregard this record type until this 
defect has been resolved. 

For additional information on campaign report access and other campaign related 

information, visit the Informed Delivery for Business Mailers website. Our full listing of known 

report issues/defects is in Informed Delivery® Mail Tracking and Reporting (IV®-MTR) 

To expand on capabilities offered by the Mailer Campaign Portal (MCP), Informed Delivery 

integrated with IV-MTR. The feature offers the following:  

¶ Near real-time data, provided as soon as its available (recurring data feed) 

¶ Two options for receiving data: one-time queries or data feeds 

¶ Data access delegation is available at the MID or CRID level 

Please note that Informed Delivery Post-Campaign (IDPC) is pass-through and not 

generated by IV-MTR. 

To find additional resources and information: 

¶ Appendix G: Data Dictionary for IV-MTR IDPC Reporting 

¶ PostalProÊ IV-MTR site 

¶ IV User Guide: Provisioning IDPC Data in IV-MTR 

For general questions on IV-MTR, please contact the Informed Delivery helpdesk. For 

questions on the IV-MTR application, please go the IV Solutions Center at 1-800-238-3150 

(Option 2) or InformedVisibility@usps.gov.  

Figure 12. Post-Campaign Detail Report (shown as two separate images due to file width, without formatting) 

http://www.usps.com/informeddeliverycampaigns'
https://postalpro.usps.com/informedvisibility
https://postalpro.usps.com/informedvisibility/provisioningIDPCdata
mailto:InformedVisibility@usps.gov
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Appendices 

Appendix A. Interactive Campaign Checklist 

Follow these steps to create an Informed Delivery interactive campaign: 

 δ
1. Choose your campaign submission method (Section 4.5): 

Å Mailer Campaign Portal ï Available via Business Customer Gateway (BCG) under 
ñOther Servicesò tab. 

Å PostalOne!® ï Contact the PostalOne! team at 

USPSInformedDeliveryeDoc@usps.gov to get started. 

 δ
2. Determine campaign level and mailing list breakdown (Section 4.1): 
Å Apply a single Informed Delivery campaign to all mailpieces/customers. 
Å Apply different campaign treatments to different customers in the same or different 

mailings. 
Å At this time, also assign a Campaign Title and Campaign Code to the interactive 

campaign and define the mailpiece shape: letter/postcard or flat. 

 δ
3. Determine MID on Piece and, if relevant, the IMb® Serial Number Range (Section 4.1): 
Å MID can belong to the mail owner, ad agency, printer, or other Mail Service Provider 

(MSP). 
o Existing MIDs can be used; full service IMb is not required. 
o MID must be printed in the IMb on the mailpieces. 

Å Gather Start and End IMb Serial Number Ranges ï if doing IMb Serialized campaigns, 
a unique and sequential range is required for each campaign or treatment. 

 δ 4. Develop supplemental content (Section 4.2): 

  δ Design creative for your Ride-along Image (required). 

 δ Determine your target URL (required). 

 δ Decide if you want to keep the grayscale mail processing image or use a color 
Representative Image (optional for letters/postcards) 

 δ

5. Determine campaign timeline (Section 4.5): 
Å USPS suggests a Start Date of 2-3 days prior to your first expected in-home date. 
Å USPS suggests an End Date 2-3 days after your last expected in-home date. 

 δ
6. Submit campaign (Section 4.5): 
Å Mailer Campaign Portal ï Enter your campaign details and supplemental content 

within the Portal. 
Å PostalOne! ï Submit campaign(s) using Mail.dat or Mail.xml. 

 δ
7. Analyze Results (Section 5): 
Å Download Post-Campaign Analyses directly in the Portal (regardless of submission 

method). 
o Summary Report ï Download information regarding the number of physical 

mailpieces, number/percentage of emails opened, and number/percentage of 
click-throughs. 

o Detailed Report ï Download detailed information, such as the time stamp of 
when a user opened an email. 

Å Retrieve mail tracking data as a one-time query or recurring data feed using Informed 
Visibility® Mail Tracking and Reporting (IV®-MTR) ï Enroll through the Business 
Customer Gateway (BCG) and IV-MTR Websites 

  

https://gateway.usps.com/eAdmin/view/signin
mailto:USPSInformedDeliveryeDoc@usps.gov
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Appendix B. Mailer ID (MID) and Intelligent Mail® Barcode (IMb®) Information 

The IMb on the mailpiece, and the contents within it, are the key to getting mailpiece images 

to users and activating Informed Delivery interactive campaigns. 

¶ The IMb is comprised of five fields: Barcode ID, Service Type ID (STID), MID, Serial 

Number, and Delivery Point ZIP Code. These fields provide intelligence such as mail 

class, service requested, mailer identification, and unique Serial Number tracking. 

o For the purposes of Informed Delivery, we only use the last 3 fields of the IMb 

(not the BI or the STID). 

¶ Grayscale scanned images are linked to Informed Delivery users based on the Delivery 

Point Code (DPC) field within the IMb. This is the nine-digit ZIP Code plus a two-digit 

Delivery Point Code value. 

¶ Only consumers/mail recipients that reside in dwellings that have a unique 11-digit 

Delivery Point Code can participate in Informed Delivery; this also applies to multi- unit 

dwellings. 

¶ Campaign images and URLs (supplemental content) are linked 

to each individual mailpiece processed based on the MID in the 

Intelligent Mail Barcode (IMb) on the actual mailpiece. 

o A MID provided in electronic postage statement 

documentation (PostalOne! eDoc) has no impact on the 

Informed Delivery campaign. See Appendix D. 

PostalOne! Specifications for PostalOne! programming 

and submission information. 

  

Figure 14. Excerpt from IMb 4-State manual (Rev H, 4/20/2015, Page 52) 

Figure 13. Illustration of IMb 

contents on individual mailpiece 



Informed Delivery® Interactive Campaign Guide 

 

© 2021 United States Postal Service. All Rights Reserved.  20 of 34 

 

Appendix C. The Mailing Lifecycle 

There are generally many different people involved in the daily mailing operations of sending 

invoices and insurance documents, staying in touch with customers, or creating and 

conducting a Direct Mail campaign. Input on decisions related to campaigns can come from 

key stakeholders throughout the company, such as Finance, IT, Marketing, Data Analytics, 

Legal, Accounting, etc. 

Additionally, there are many companies that provide support for day-to-day mailing 

operations or Direct Mail marketing campaigns. Mail Service Providers (MSPs) support mail 

owners with mail printing, addressing, barcoding, sorting, distribution, and/or commingling. 

Ad Agencies support mail owners with media decisions, campaign creative, mailpiece 

design, and more. 

Organizations should involve key stakeholders and support teams in the development cycle 

of an Informed Delivery interactive campaign too. 

Since the MID or, more commonly, the MID + IMb Serial Number on the mailpiece is key to 

activating a campaign, the person responsible for this data element is critical to campaign 

success. Properly segregating your mailing list prior to assigning the IMb or placing it on the 

mailpieces is key. 

Example: A company is mailing to 15,000 customers. This company uses a single six-digit 

MID. This company tests three different mailpiece treatments to see which one gets the best 

response rate. This company creates three unique vanity URLs to go in these mailpieces to 

track visits to their webpage and attribute them back to each mailpiece type. 

To apply a different Informed Delivery campaign to each mailpiece type (or groups of 

customers), the company needs to ensure that their mailing list is broken down into three 

separate/unique lists. Each list would be printed separately, in succession, so the company 

will end up with three unique, sequential and non-overlapping ranges of IMb Serial 

Numbers. With this result, the company can apply three unique Informed Delivery 

campaigns, each with its own supplemental content (Ride-along and/or Representative 

Image, and URL. 

 

Figure 15 

Figure 16. Illustration of mailing list breakdown for Informed 
Delivery campaign use 
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Appendix D. PostalOne! Specifications 

Mailers using the PostalOne! Mail.dat or Mail.xml file formats are able to submit Informed 

Delivery interactive campaign information electronically. 

¶ The Informed Delivery Mail.dat or Mail.xml files are sent as part of a larger Mail.dat or 

Mail.xml job that contains presort and postage statement information; other presort and 

postage supporting files are also submitted along with the Informed Delivery files. 

Documents regarding the specific programming requirements and processes for PostalOne! 

campaign submissions are provided as links on the Informed Delivery for Business Mailers 

website. An overview of the required PostalOne! onboarding can be found below. 

PostalOne! Onboarding & Contact Information 

All mailers that wish to conduct/submit campaigns using PostalOne! are required to work 

with the PostalOne! Customer Acceptance Testing (CAT) office for Informed Delivery 

interactive campaigns. This PostalOne! team can be reached directly by emailing 

USPSInformedDeliveryeDoc@usps.gov  

PostalOne! Onboarding Check List 

Follow the steps outlined below to set up your Customer Acceptance Testing (CAT) 

Business Customer Gateway (BCG) account and conduct an Informed Delivery campaign 

using PostalOne!: 

¶ Email the Informed Delivery eDoc team at USPSInformedDeliveryeDoc@usps.gov 

stating initial intent to start testing Informed Delivery Campaigns using PostalOne!. 

Please provide the following information: 

o Point of contact name 

o Phone number 

¶ Coordinate with USPS to determine if the mailer submitting the campaign has 

participated in PostalOne! Customer Acceptance Testing (CAT) in the past. 

¶ If the organization has participated in PostalOne! CAT, please acquire the PostalOne! 

CAT credentials below. These credentials will allow the organization to create a Mail.dat 

eDoc job for an Informed Delivery campaign. 

o Username 

o Password 

o Customer Registration ID (CRID) 

o Mailer ID (MID) 

o Permit account number 

o ZIP CodeÊ related to the Permit 

Set Up Your PostalOne! CAT Account with Permit 

1. Visit the USPS BCG CAT environment. 

2. Create a BCG account: 

a. Click on ñRegister for Free.ò 

b. Choose a username and password. 

c. Provide security information. 

d. Provide phone and email contact information. 

e. Provide company name, information, and address. 

i. A BCG Business Account will be granted upon completion of these fields. 

The user will be automatically assigned a mailer CRID and MID. Those 

https://www.usps.com/business/informed-delivery.htm
mailto:USPSInformedDeliveryeDoc@usps.gov
https://gateway-cat.usps.com/eAdmin/view/signin
mailto:USPSInformedDeliveryeDoc@usps.gov
https://gateway-cat.usps.com/eAdmin/view/signin


Informed Delivery® Interactive Campaign Guide 

 

© 2021 United States Postal Service. All Rights Reserved.  22 of 34 

 

credentials appear on-screen within the application and will be sent to the 

registered email address on file. 

3. Email the Informed Delivery eDoc team the following information: 

a. CRID 

b. MID 

c. Company name, address, and point of contact 

4. Request that a Permit Imprint Postage Payment Account be created and activated. 

a. Note: The Permit should be funded with a large test balance amount so that Mail.dat 

jobs with postage and campaign data can be submitted. 

5. Once the CAT BCG account has been created, the CAT office will link the newly created 

Permit to the mailer test CRID. 

6. The CRID, MID, and Permit Account Number information can now be used to prepare 

and submit Mail.dat jobs with Informed Delivery campaigns to PostalOne! CAT. 

7. The PostalOne! CAT Mail.dat client can be downloaded from the PostalOne! BCG CAT 

page after logging in. 

8. The Informed Delivery eDoc team will validate the eDocs data and provide feedback if 

data needs to be corrected to be eligible for production environment. 

Any questions or information related to PostalOne! or the process outlined above can be 

sent to the Informed Delivery eDoc team. 

All general campaign questions related to supplemental content specifications, reporting, 

etc., must be directed to the USPSInformedDeliveryCampaigns@usps.gov email. 

  

https://gateway-cat.usps.com/eAdmin/view/signin
https://gateway-cat.usps.com/eAdmin/view/signin
mailto:USPSInformedDeliveryCampaigns@usps.gov
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Appendix E. Formatting Pre-Campaign Analysis File 

To run a Pre-Campaign Analysis, the following file formatting requirements must be met or 

the file upload will fail: 

¶ The column header must read ZIP11. 

¶ Each entry must be an 11-Digit Delivery Point ZIP Code. Any entry that is not an 11-Digit 

Delivery Point ZIP Code should be deleted. 

¶ Include leading zeroes. 

¶ Remove duplicate codes. 

¶ Save as a Comma Separated Values (.csv) file (using lowercase .csv). 

¶ Break files into 102,400 KB (or 100MB) or less. 

The following steps will provide guidance on how to format your Pre-campaign analysis file 

correctly, including how to: 

¶ Extract the 11-digit Delivery Point Codes (DPC) from IMbôs, and;  

¶ Confirm that every entry contains only 11-digit DPCs. 

11-digit DPCs are a key part of the Intelligent Mail Barcode (IMb). There are five fields in the 

IMbð the DPC is in the last/fifth field (see Appendix B. Mailer ID (MID) and Intelligent 

Mail® Barcode (IMb®) Information). The easiest way to identify DPCs is from a recent 

mailing that was conducted. The printer/vendor should have access to this data. Keep in 

mind that most customer databases do not store DPCs. 

1. Extract DPCs out of an IMb to prepare the Pre-Campaign Analysis file. 

1.1. Open the IMb file in Notepad to ensure you have only IMbôs in the file, and save it to 
your computer. 

 

1.2. Open a new instance of Microsoft Excel, and import the Text file by following the 
steps below. 
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1.2.1 Open the Data tab, and then select ñFrom Textò in the ñGet External Dataò section. 
Note: If you are working in Excel 2016 in O365 or later, the Text Import Wizard 
(below) may no longer be enabled. To enable it, navigate to File > Options > Data 
and select ñFrom Text (Legacy)ò under the ñShow legacy data import wizardsò 
section. 

 

1.2.2 Select the file that contains your IMbôs and click ñImport.ò The Text Import Wizard will 
appear. 

 

1.2.3. Using your mouse, click to the right of the first two characters of the numbers 
showing in the ñData previewò section. This will insert an arrow as shown below. 
Repeat this step four more times to insert these arrows in between each of the five 
IMb sections. Select ñNext.ò Important Note: Your MID could be six or nine digits in 
lengthðand your IMb Serial Number is also six or nine digits long. It is imperative 
that you know the MID used before you complete this step.  
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1.2.4. Select ñTextò under Column data format. Then, select ñFinish.ò 
 

1.2.5. An Import Data window will appear. Select ñExisting Worksheetò to indicate how you 
want to view this data in your workbook (default option). 

 

1.2.6. Content will be imported into Excel into five columns. The fifth column (Column E) 
contains the 11-digit DPC. 
 

1.3 Delete columns A through D. Keep column E 

 



Informed Delivery® Interactive Campaign Guide 

 

© 2021 United States Postal Service. All Rights Reserved.  26 of 34 

 

2. Verify if the .CSV File is properly formatted for submission in the Mailer 

Campaign Portal. 

2.1. Open a new Excel file. 

2.2. Open the Data tab, then select ñFrom Textò in the ñGet External Dataò section. 
 

2.3. Select the file that contains your 11-digit Delivery Point Barcodes from your IMbôs; 
select ñImport.ò 

 

2.4. Leave the delimiters as is (ñTabò). Click ñNext.ò 

2.5. Select ñText.ò 

2.6. The data will import into your Excel document. 


















